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Microsoft Office 2007 Series of E-books 
 
The Ultimate Guide to Excel 2007! Ebook with Free Bonuses 
 
How YOU can easily master your Excel 2007 skills and solve your everyday Excel-related 
projects in the comfort of your own home? 
 
To discover the Secrets to Unlock Your Excel Potentials and save more time for yourself, you are 
invited to see for yourself when you go to http://www.msoffice-tutorial-training.com/excel-
2007-book.html 
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Revealed - The Practical, Step-By-Step, Roadmap To Enjoy The Totally Risk-Free, Guarantee 
Satisfaction Of Mastering The PowerPoint 2007 Program Easily At Your Own Pace! 
 
If you wish to know the ófast-trackô way to help you create a dynamic PowerPoint presentation 
with credibility, please visit the http://www.msoffice-tutorial-training.com/powerpoint-2007-
book.html for more information. 
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Introduction 
 
 
The release of the 2007 Microsoft Office system, including new and improved 
desktop applications and server software, is another milestone for Microsoftôs 
suite of business productivity software. The Office 2007 consists of several 
editions that each comes with a specific mix of desktop programs. 
 
Microsoft Office 2007 features five newly enriched and redesigned programs: 
Word, Excel, PowerPoint, Access, and Outlook. Each of these core programs 
specializes in manipulating different data. Word manipulates words, sentences, 
and paragraphs; Excel manipulates numbers, formula and charting; PowerPoint 
manipulates text and pictures to create a slide show; Access manipulates data, 
such as inventories; and Outlook manipulates personal information, such as e-
mail addresses and phone numbers. 
 
The 2007 Office release has updated versions of Microsoft Office InfoPath, 
Microsoft Office OneNote, and Microsoft Office Visio. Two newly added desktop 
program are Microsoft Office Groove 2007 (a collaboration and information 
sharing application) and Microsoft Office SharePoint Designer 2007 (a Web site 
design and solution development tool). 
 
The 2007 Microsoft Office system also includes server products, such as 
Microsoft Office SharePoint Server 2007, Microsoft Office Communications 
Server 2007, etc. 
 
The combination of server innovations and a redefined desktop experience 
delivers business solutions that help simplify how people work together, better 
protect and manage content, improve business processes, and find and gain 
insight from information.  
 
The aims of this book are to let you quickly pick up the Office 2007 system no 
matter you are new Office 2007 user or upgrade from the earlier versions of 
Office.  
 
For more free Office 2007 tutorials, please visit http://www.msoffice-tutorial-
training.com/office-2007.html  
 

 

http://www.msoffice-tutorial-training.com/office-2007.html
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Chapter 1: Microsoft Office 2007 Versions 
 
 
Office 2007 versions! Which version are you looking for? 
 
Here are the available versions: Basic, Home/Student, Standard, Small 
Business, Professional and Ultimate version. 
 
The various available versions for Office 2007 packages (which programs 
comprise each one of them) sold in OEM and FPP editions. 
 
OEM (Original Equipment Manufacturer) - It can only come pre-installed with a 
new computer. The OEM license is tied to the computer system with which it 
has been sold and cannot be transferred to another computer. Moreover, the 
OEM license cannot be the Upgrade version, it is always the Full version. 
 
FPP (Full Packaged Product) - It can be bought as a stand-alone piece of 
software. The FPP license can be either the Full or the Upgrade version.  
 
 

The OEM and FPP Edition Overview 
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They are various available versions for Office 2007 packages (which programs 
comprise each one of them), sold in Volume Licensing versions. 
 
 

The Volume Licensing Edition Overview 
 

 
 
 
 

Advantages of Volume Licensing 
 
When you planning to buy Office 2007 system or upgrade from the previous 
version of Office, you can choose the different types of licenses: FPP, OEM or 
Volume Licensing as describe above. But you really need to know the 
advantages of Office 2007 volume licensing version over OEM or FPP licenses. 
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Office 2007 Additional Features 
 
Three of the available Office 2007 packages, namely Office Ultimate 2007 
(available as FPP only), and Office Professional Plus 2007 and Office Enterprise 
2007 (available in Volume Licensing only), provide additional collaboration 
features in Word, Excel, PowerPoint, and Outlook.  
 
These unique features support the following scenarios: 

¶ Implement Enterprise Content Management: In Word 2007, Excel 2007, and 
PowerPoint 2007, users can view or edit document properties easily while 
they work on document content by using the Document Information Panel, 
which appears at the top of the document in the Office program. 

¶ Support and automate processes using forms and workflow: Users can build 
forms with InfoPath and embed these within Office documents. 

¶ Protect documents with persistent security: Integration with Windows Rights 
Management Services enables authors to set permissions for documents that 
they create. Only after successful authentication can others access or edit the 
documents to the extent determined by the author. 
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Chapter 2: Microsoft Office 2007 Pricing  
and Upgrade Information 

 
 
Below is the estimated retail pricing (ERP) information for the Microsoft Office 
2007 system price. The new and improved lineup has been designed to help 
meet the business and personal needs of large enterprises, small and midsize 
businesses, at-home users, and students and teachers.  
 
In addition to retail options, organizations will be able to purchase these 
products, servers and solutions through Microsoft Volume Licensing programs 
(for as few as five licenses) and Original Equipment Manufacturers (OEMs). 
 
Note: All prices are in U.S. dollars. 
 

Microsoft Office 2007 Suites Retail Price/Upgrade Price* 

Microsoft Office Enterprise 2007 New! 
 

Available only through volume 
licensing; price not quoted 

Microsoft Office Professional Plus 2007  
 

Available only through volume 
licensing; price not quoted 

Microsoft Office Ultimate 2007 New! $679.95/$539.95 

Microsoft Office Professional 2007 $499.95/$329.95 

Microsoft Office Small Business 2007 $449.95/$279.95 

Microsoft Office Standard 2007 $399.95/$239.95 

Microsoft Office Home and Student 2007  $149.95/NA 

Microsoft Office Basic 2007 Available only through OEMs; 
price not quoted 

Microsoft Office 2007 Programs  

Microsoft Office Access 2007 $229/$109.95 

Microsoft Office Accounting Professional 2008 $199.95/$149.95 

Microsoft Office Communicator  Available only through volume 
licensing; price not quoted 

Microsoft Office Excel® 2007 $229/$109.95 

Microsoft Office Groove® 2007 New! Available only through volume 
licensing; price not quoted 
See below for service offering 
option. 

Microsoft Office InfoPath® 2007 $199/NA 

Microsoft Office OneNote® 2007 $99.95/79.95 

Microsoft Office Outlook® 2007 $109.95/NA 
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Microsoft Office PowerPoint® 2007 $229/$109.95 

Microsoft Office Project Standard 2007 $599.95/$349.95 

Microsoft Office Project Professional 2007 $999.95/$599.95 

Microsoft Office Publisher 2007 $169.95/$99.95 

Microsoft Office SharePoint® Designer 2007  $299.95/159.95 

Microsoft Office Visio® Standard 2007 $259.95/$129.95 

Microsoft Office Visio Professional 2007 $559.95/$349.95 

Microsoft Office Word 2007 $229/$109.95 

 

Microsoft Office 2007 Servers  

Microsoft Office Forms Server 2007 New! Available only through volume 
licensing; price not quoted 

Microsoft Office Groove Server 2007 New! Available only through volume 
licensing; price not quoted 

Microsoft Office Communications Server 2007 
New! 

Available only through volume 
licensing; price not quoted 

Microsoft Office Project Server 2007 Available only through volume 
licensing; price not quoted 

Microsoft Office Project Portfolio Server 2007 
New! 

Available only through volume 
licensing; price not quoted 

Microsoft Office SharePoint Server 2007 Available only through volume 
licensing; price not quoted 

Microsoft Office SharePoint Server for Search 
2007 New! 

Available only through volume 
licensing; price not quoted 

Microsoft 2007 Client Access Licenses 
(CALs) 

 

Microsoft Core CAL Available only through volume 
licensing; price not quoted 

Microsoft Enterprise CAL New! Available only through volume 
licensing; price not quoted 

Programs available via Web access  

Microsoft Office Communicator Web Access 
New! 

Available only through 
licensing; price not quoted 

Microsoft Office Outlook Web Access Available only through 
licensing; price not quoted 

Microsoft Office Project Web Access  Available only through 
licensing; price not quoted 

Services  

Microsoft Office Groove Enterprise Services 
New! 

Available only through volume 
licensing; price not quoted 

Microsoft Office Live Groove New! $79 yearly subscription 

Microsoft Office Live New! Office Live offerings range 
from free domain name, Web 
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site and company e-mail 
accounts that are advertising-
supported to more 
comprehensive services 
available on a subscription-fee 
basis. The offerings can be 
especially attractive to 
companies with 10 or fewer 
employees, which typically lack 
in-house technical resources or 
the budget to keep an IT 
person on staff. 

Tools   

Microsoft Office Outlook 2007 with Business 
Contact Manager  

Available only through 
licensing; price not quoted 
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Chapter 3: Microsoft Office 2007 System Packaging 
 
 
The 2007 Microsoft Office system, including new and improved desktop 
applications and server software, is available to business and retail customers as 
of 30 Jan. 2007.  
 
The combination of server innovations and a redefined desktop experience 
delivers business solutions that help simplify how people work together, better 
protect and manage content, improve business processes, and find and gain 
insight from information. Ultimately, this amplifies the impact people can have on 
business success.  
 
With additional functionality and updated packaging options, or stock keeping 
units (SKUs), Microsoft Office customers will have more flexibility than ever 
before to purchase the specific technologies and solutions that best meet their 
unique business needs. 
 
Below are overviews of the Microsoft Office 2007 system products to help meet 
the business and personal needs of large enterprises, small and midsize 
businesses, at-home users, and students and teachers. 
 
  

Microsoft Office 2007 Suites  
Microsoft Office Enterprise 2007 
New! 
 
Includes: 

¶ Microsoft Office Excel® 2007 

¶ Microsoft Office Outlook® 2007 

¶ Microsoft Office PowerPoint® 
2007 

¶ Microsoft Office Word 2007 

¶ Microsoft Office Access 2007 

¶ Microsoft Office InfoPath® 
2007 

¶ Microsoft Office Communicator 

¶ Microsoft Office Publisher 
2007 

¶ Microsoft Office OneNote® 

 
Building on the strengths of Microsoft 
Office Professional Plus 2007, the new 
Office Enterprise 2007 suite will help 
teams share information easily and 
more securely across geographic and 
organizational boundaries. Individuals 
can stay productive whether or not they 
are online.  
 



This e-book provided by http://www.msoffice-tutorial-training.com. Visit the 
site for more FREE Office 2007 & 2003 tutorials and information. 

 

 

Microsoft, the Office Excel, Outlook, PowerPoint, InfoPath, OneNote, Groove, SharePoint, Word, Fluent, Visio, 
PerformancePoint and Windows Server are either registered trademarks or trademarks of the Microsoft group of 

companies in the United States and/or other countries.  13 
 

2007  

¶ Microsoft Office Groove® 2007 

¶ Integrated solution capabilities 
such as enterprise content 
management (ECM), 
electronic forms, and 
information rights and policy 
capabilities 

 

Microsoft Office Professional Plus 
2007  
 
Includes: 

¶ Microsoft Office Excel 2007 

¶ Microsoft Office Outlook 2007 

¶ Microsoft Office PowerPoint 
2007 

¶ Microsoft Office Word 2007 

¶ Microsoft Office Access 2007 

¶ Microsoft Office InfoPath 2007 

¶ Microsoft Office Communicator 

¶ Microsoft Office Publisher 
2007 

¶ Integrated solution capabilities 
such as ECM, electronic 
forms, and information rights 
and policy capabilities 

 

 
Office Professional Plus 2007, the new 
name for an updated release of 
Microsoft Office Professional Enterprise 
Edition 2003, will deliver a powerful set 
of tools designed to help people and 
organizations work more efficiently with 
information. Through integration with 
new Microsoft Office SharePoint® 
Server 2007 and Microsoft Windows® 
SharePoint Services capabilities, Office 
Professional Plus 2007 will offer 
advances in teamwork solutions. 
 
 

Microsoft Office Ultimate 2007 
New! 
 
Includes: 

¶ Microsoft Office Excel 2007 

¶ Microsoft Office Outlook 2007 
with Business Contact 
Manager 

¶ Microsoft Office PowerPoint 
2007 

¶ Microsoft Office Word 2007 

¶ Microsoft Office Access 2007 

¶ Microsoft Office InfoPath 2007 

¶ Microsoft Office Publisher 
2007 

 
Office Ultimate 2007 will give people 
working at home access to the full 
lineup of 2007 Microsoft Office 
applications so they can create, find, 
manage and share information across 
boundaries using the toolset theyôre 
familiar with at the office.  
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¶ Microsoft Office OneNote 2007 

¶ Microsoft Office Groove 2007 

¶ Microsoft Office Accounting 
Express 2007*  

¶ Integrated solution capabilities 
such as ECM, electronic 
forms, and information rights 
and policy capabilities 
 

Microsoft Office Professional 2007 
 
Includes: 

¶ Microsoft Office Excel 2007 

¶ Microsoft Office Outlook 2007 
with Business Contact 
Manager 

¶ Microsoft Office PowerPoint 
2007 

¶ Microsoft Office Word 2007 

¶ Microsoft Office Access 2007 

¶ Microsoft Office Publisher 
2007 

¶ Microsoft Office Accounting 
Express 2007 
 

 
Office Professional 2007 is a complete, 
easy-to-use suite of productivity and 
information management software to 
help business professionals save time 
and stay organized. Powerful features 
will centralize customer, sales and 
project information in one place so 
users can respond more quickly to 
opportunities. Enhanced tools will help 
create professional-quality business 
and marketing publications, documents 
and presentations in-house.  
 

Microsoft Office Small Business 
2007 
 
Includes: 

¶ Microsoft Office Excel 2007 

¶ Microsoft Office Outlook 2007 
with Business Contact 
Manager 

¶ Microsoft Office PowerPoint 
2007 

¶ Microsoft Office Word 2007 

¶ Microsoft Office Publisher 
2007 

¶ Microsoft Office Accounting 
Express 2007 

 
Office Small Business 2007 is the 
complete, powerful and easy-to-use 
productivity and contact management 
suite. It will offer new tools to help 
employees at small businesses work 
more efficiently and effectively so they 
can deliver better customer service. 
People will be able to organize all their 
customer and prospect information in 
one place, as well as develop more 
professional presentations, marketing 
materials and campaigns in-house. 
 

Microsoft Office Standard 2007 
 
Includes: 

Office Standard 2007 will be the 
software suite that empowers home and 
small-business customers to effectively 
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¶ Microsoft Office Excel 2007 

¶ Microsoft Office Outlook 2007 

¶ Microsoft Office PowerPoint 
2007 

¶ Microsoft Office Word 2007 

manage e-mail and easily create great-
looking documents, spreadsheets and 
presentations. Office Standard 2007 will 
make it easier for people to get things 
done, with improved menus and tools 
including enhanced graphics and 
formatting capabilities, new time-
management tools as well as greater 
reliability and enhanced security. 
 

Microsoft Office Home and Student 
2007  
 
Includes: 

¶ Microsoft Office Excel 2007 

¶ Microsoft Office PowerPoint 
2007 

¶ Microsoft Office Word 2007 

¶ Microsoft Office OneNote 2007 

Office Home and Student 2007 will be 
the software suite that helps people 
easily create great-looking documents, 
worksheets and presentations, as well 
as manage notes and information at 
home. It will offer improved menus and 
tools, enhanced graphics and 
formatting capabilities, new time 
management tools, and greater 
reliability and security. 

Microsoft Office Basic 2007 
 
Includes: 

¶ Microsoft Office Excel 2007 

¶ Microsoft Office Outlook 2007 

¶ Microsoft Office Word 2007 

Office Basic 2007 will provide office 
software essentials to homes and small 
businesses so people can quickly and 
easily create great-looking documents 
and worksheets, as well as manage e-
mail. It will deliver improved menus and 
tools, enhanced graphics and 
formatting capabilities, new time-
management tools, and greater 
reliability and security. 

 
*Microsoft Office Accounting Express is only available in the U.S.  
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Chapter 4: Microsoft Office 2007 Programs Overview 
 
 
If you are not sure or new to the Office 2007 suites of programs, this chapter will 
give you an overview of the each Office 2007 application. 
 

Microsoft Office 2007 Programs 
 
Microsoft Office Access 2007 
With Office Access 2007, information workers will be able to track and report 
information with ease, using the new Microsoft Office FluentÊ interface and 
interactive design capabilities that do not require deep database knowledge or 
programming skills. Information-sharing will be enabled through Windows 
SharePoint Services lists, which can be audited and backed up easily. 
 
Microsoft Office Communicator 2007 
Office Communicator will provide security-enhanced, enterprise-grade instant 
messaging capability with enhanced voice, video and telephony integration. 
 
Microsoft Office Excel 2007 
Office Excel 2007 will be a powerful tool to help people analyze, communicate 
and manage information to make more informed decisions. When Office Excel 
2007 is used with Office SharePoint Server 2007, customers will be able to take 
advantage of Excel Services, a new, server-based version of Excel that is 
optimized for creating, managing and sharing spreadsheets. Excel Services 
makes the most of the power of Office SharePoint Server 2007 so people have 
new opportunities to use Office Excel 2007 for business intelligence. 
 
Microsoft Office Groove 2007 New! 
Office Groove 2007, an updated release of Groove Virtual Office software, will 
enable teams to work together dynamically inside collaborative work spaces 
regardless of location or network connection. Available as Chapter of the new 
Office Enterprise 2007 suite and as a stand-alone product, Groove 2007 will 
feature new integration with Windows SharePoint Services, Office SharePoint 
Server 2007, Office InfoPath 2007, and Office Communicator. It will also be 
localized to support 28 languages. 
 
Microsoft Office InfoPath 2007 
With Office InfoPath 2007, customers will be able to create rich, dynamic forms 
that teams and organizations can use to gather, share, reuse and manage 
information, improving collaboration and decision-making throughout 
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organizations. Customers will also be able to use the Office InfoPath Forms 
Services capabilities in Office SharePoint Server 2007 to extend business 
processes beyond the corporate firewall and deliver forms as Office Outlook 
2007 e-mail messages, Web browser forms, or forms for mobile devices. 
 
Microsoft Office OneNote 2007 
With Office OneNote 2007, people will be able to gather virtually any type of 
information ð from typed text, audio and video to handwritten notes and 
drawings, technical graphics and research from the Web or other applications. It 
will provide powerful search tools to find information quickly, as well as easy-to-
use sharing tools that will help people manage information overload and work 
with others more effectively. 
 
Microsoft Office Outlook 2007 
The Office Outlook 2007 messaging and collaboration client will provide an 
integrated solution to help people better manage their time and information, 
connect across boundaries and remain safer. This comprehensive information 
and time manager will help workers organize and quickly search for information, 
as well as deliver new tools that make it easier to prioritize tasks or time. With 
Office Outlook 2007, information can be shared between co-workers, friends and 
family with enhanced security, virtually anywhere. 
 
Microsoft Office PowerPoint 2007 
Office PowerPoint 2007 will give people a powerful solution to address their 
presentation needs by making it easier to create impressive and dynamic 
presentations quickly. As a result, customers will save time when formatting and 
creating slides, so they can focus on the quality of the content. 
 
Microsoft Office Project Standard 2007 
Office Project Standard 2007 will deliver robust project management tools with 
the right blend of usability, power and flexibility so people can manage projects 
more efficiently and effectively. Customers will be able to more effectively 
manage project work, schedules and finances; keep project teams aligned; and 
be more productive as a result of tools integrated with familiar Microsoft Office 
system programs, powerful reports, guided planning and flexible tools. 
 
Microsoft Office Project Professional 2007 
For more advanced project management and collaboration needs, Office Project 
Professional 2007 can connect with Microsoft Office Project Server 2007 and will 
include all the stand-alone functions offered in Office Project Standard 2007. 
 
Microsoft Office Publisher 2007 
Office Publisher 2007 will help people create and distribute a wide variety of 
high-quality publications and marketing materials ð from single-page fliers to 
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more complex brochures, catalogs and e-mail newsletters. New tools will guide 
customers through the process of compiling mailing lists as well as creating, 
publishing, distributing and printing materials. 
 
Microsoft Office SharePoint Designer 2007 New! 
Office SharePoint Designer 2007 will provide the powerful tools needed to deliver 
compelling and attractive SharePoint sites and quickly build workflow-enabled 
applications and reporting tools on the SharePoint platform, all in an IT-managed 
environment. 
 
Microsoft Office Visio® Standard 2007 
Office Visio Standard 2007 will make it easy for business professionals to 
visualize and communicate complex information, processes and ideas with 
professional-looking diagrams. By using Office Visio 2007, people will be able to 
easily create diagrams to visualize complex information, present them 
professionally and share them broadly for effective and efficient decision-making. 
 
Microsoft Office Visio Professional 2007 
Office Visio Professional 2007 will make it easy for IT and business professionals 
to visualize, analyze and communicate complex information, systems and 
processes with clear, compelling diagrams. By using Office Visio 2007, people 
will be able to easily visualize information from multiple data sources to better 
understand the current state of systems and processes, analyze information 
visually to highlight key trends and exceptions, and share diagrams broadly for 
effective and efficient decision-making. 
 
Microsoft Office Word 2007 
Office Word 2007 will help people create and share professional-looking 
documents by combining a comprehensive set of writing tools with a new results-
oriented Office Fluent user interface. 
 
 

Microsoft Office 2007 Servers 
 
Microsoft Office Forms Server 2007 New! 
Office Forms Server 2007 will provide a scalable, security-enhanced, standards-
based solution that centralizes control and management of electronic forms by 
allowing customers to use a common Web browser to interact with information. It 
will help streamline organizationsô forms-driven business processes with existing 
systems. 
 
Microsoft Office Groove Server 2007 New! 
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Office Groove Server 2007 will provide IT organizations with enterprise-class 
server software and tools to deploy, manage and integrate Office Groove 2007 
across the enterprise. 
 
Microsoft Office PerformancePointÊ Server 2007 New! 
Office PerformancePoint Server 2007 is a complete performance management 
application that includes business scorecarding, analytics and planning 
capabilities to help enable employees to more effectively plan and manage their 
operations. It delivers performance management capabilities across all 
deChapterments of the business including Finance, Operations, Sales, Marketing 
and Human Resources using the familiar Microsoft Office environment to greatly 
expand the reach of the application. 
 
Microsoft Office Project Server 2007 
Office Project Server 2007 will help organizations align people and work with 
business priorities, automate project management processes, enable effective 
communication and collaboration across the organization, and manage work 
from ad-hoc projects to complex programs across the entire project life cycle. 
 
Microsoft Office Project Portfolio Server 2007 New! 
Office Project Portfolio Server 2007 will be a top-down portfolio management 
governance solution. The solution has been designed to help ensure that 
organizations gain visibility, insight and control over their project, program and 
application portfolios. Project Portfolio Serverôs analytical modules will help 
ensure that organizations can prioritize, optimize and select the investments that 
are best aligned with their strategic priorities, and proactively schedule the 
selected projects to maximize resource utilization across the planning horizon. 
 
Microsoft Office SharePoint Server 2007 
Office SharePoint Server 2007 will unify portal and content management, 
business insight and business process capabilities to help organizations 
collaborate more effectively, make more-informed decisions and control content. 
In addition, Office SharePoint Server 2007 will give IT professionals the tools 
they need for server administration, application extensibility and interoperability. 
 
Microsoft Office SharePoint Server for Search 2007 New! 
A subset of the complete Office SharePoint Server 2007, SharePoint Server for 
Search 2007 will provide midmarket and deChaptermental enterprise customers 
with core search capabilities. Depending on a customerôs needs, it can either 
crawl content in common data repositories ð such as file shares, Web sites and 
servers ð or be extended to search other repositories using third-Chaptery or 
custom-built connectors. 
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Microsoft Client Access Licenses (CALs) 2007 
 
Microsoft Core CAL 
The Core CAL, available today, combines the access licenses for popular 
Microsoft servers, including Windows ServerÊ, Exchange Server, Office 
SharePoint Portal Server and Systems Management Server. 
 
Microsoft Enterprise CAL New! 
The Enterprise CAL will consist of the Core CAL plus new capabilities such as 
enterprise data searching, spreadsheet publishing, Web-based form creation and 
unified messaging. It also includes new offerings from Microsoft Operations 
Manager, Microsoft Office Live Communications Server, Windows Rights 
Management Services and Microsoft security products. 
 
Microsoft Office Communicator Web Access New! 
Office Communicator Web Access extends Communicator customersô security-
enhanced, enterprise-grade instant messaging capability to any PC with a Web 
browser and an Internet connection. 
 
Microsoft Office Outlook Web Access 
With Microsoft Exchange Server, Office Outlook Web Access provides the best 
Outlook experience available in a Web browser. It offers users the same rich 
interface they will experience with Office Outlook 2007. 
 
Microsoft Office Project Web Access 
Project Web Access, the Web-based interface to Office Project Server 2007, 
enables people to view, analyze and report on data as well as enter schedule 
status, create proposals and work on projectsô resources. 
 
 

Microsoft Office 2007 Services 
 
Microsoft Office Groove Enterprise Services New! 
Office Groove Enterprise Services will deliver cost-effective Web-based services 
for managing smaller Office Groove 2007 deployments without any on-site 
infrastructure requirements. 
 
Microsoft Office Live Groove New! 
Office Live Groove 2007 will be the subscription-based Office Groove offering for 
small businesses and workgroups. It will include all the capabilities of the Office 
Groove 2007 desktop application plus Microsoft-hosted data relay services and 
product updates. 
 
Microsoft Office Live New! 
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Office Live offers small-business customers an opportunity to experience new 
Internet-based business services. Office Live combines the power of software 
with the accessibility of the Internet to offer advanced, Web-based capabilities for 
small companies that want an online presence. Office Live is designed to give 
small businesses the same advantages as larger enterprises by getting them up 
and running on the Internet quickly and easily. 
 
Microsoft Office Accounting Express New! 
With Office Accounting Express 2007, users can manage financial tasks and 
integrate online business with online services such as eBay, PayPal and 
Equifax.** 
 
** Services are available for additional fees. 
 
 
For more free Office 2007 tutorials, please visit http://www.msoffice-tutorial-
training.com/office-2007.html 

http://www.msoffice-tutorial-training.com/office-2007.html
http://www.msoffice-tutorial-training.com/office-2007.html
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Chapter 5: Whatôs New in Microsoft Office 2007? 
 
 
The Office 2007 differs substantially from the previous versions, both in 
appearance and functionality. Traditional menus, toolbars, and task panes have 
been replaced by a new navigation system and a multitude of new features 
that are designed to make accomplishing tasks in the application easier than 
ever before. This chapter covers óWhat is new in Office 2007?ô 

 
 

Interface Changes 
 
Office 2007 programs have changed quite a bit in appearance; however, most of 
the features are still the same. The features, buttons, and tabs do have more of a 
3D look and feel now though, and you will notice many bugs have been worked 
out as features have been enhanced. The most significant change is the 
organization of tools and commands. The following are descriptions of the major 
interface changes. 
 
 
Office Button  
 
The Office Button displays a new menu that replaced the old File menu in 
previous versions of Office programs. This new menu shows icons next to the 
commands, letting new users associate the icons with the commands.  
 
Related options are now grouped together. For example, previous Office 
programs listed Save As and Save as Web Page separately. On the new menu, 
when you mouse over the Save As option, additional options appear. 
 
 
The Quick Access Toolbar  
 
The Quick Access Toolbar located right beside the Office Button. It is 
comparable to the Standard toolbar in earlier versions of Office programs. With 
the new Ribbon, by default it contains 3 buttons but you can customize the 
toolbar to include other buttons that are frequently used.  
 
To add or remove buttons, click the down arrow. When the Customize Quick 
Access Toolbar menu appears, select or deselect an option. (Checked options 
are already included in the Quick Access Toolbar.) 
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The Ribbon 
The Ribbon is a bar across the top of the window that contains tabbed pages of 
commands and icons/buttons. Previous versions of Office interface included a 
complicated set of toolbars and menus. These have been replaced by the 
Ribbon. Instead of the old menu bar, which included the drop-down menus like 
File, Edit, View, Insert, etc., the Ribbon (shown below) contains tabs and 
grouped commands. 
 
Here are the elements in Office 2007 ribbon: 

¶ Ribbon: The whole bar, including all of the tabs. 

¶ Tab: A tabbed page of the Ribbon such as Home, Insert, etc. Every tab 
contains several groups and every group has its own command icons. 

¶ Group: A section of a tab. For example, the Home tab has the following 
groups: Clipboard, Font, Paragraph, Styles, and Editing. 

¶ Dialog box launcher: A small icon in the bottom-right corner of a group, from 
which you can open a dialog box related to that group. 

 
There is no way to delete or replace the Ribbon with the toolbars and menus 
from the earlier versions of Microsoft Office. However, you can minimize the 
Ribbon to make more space available on your screen. To quickly minimize the 
Ribbon, double-click the name of the active tab. Double-click a tab again to 
restore the Ribbon. 
 
Note: To minimize or restore the Ribbon using keyboard shortcut, press 
Ctrl+F1. 
 
Tabs 
Each tab corresponds to a task. For example, in Word, the Home tab contains 
the most commonly used writing tools, such as the font formatting options and 
style options. Additional tabs will appear in a program based on an action. For 
example, if you are working with a header or footer, the Header & Footer Tools 
tab will display. Such tabs are called contextual tabs. 
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Most Office 2007 programs also contain the Ribbon, with the first tab including 
commands for the key functions. The primary tab in Word, Excel, PowerPoint, 
and Access is the Home tab. In Outlook, when you create a message or 
appointment, the Ribbon displays with the Message tab first. 
 
Groups 
Groups are units of related commands (buttons, menus, drop-down lists, etc.) 
They include each command needed for a certain task. The groups on the Excel 
Home tab include Clipboard, Font, Alignment, Number, Styles, Cells, and Editing. 
The example below shows the Clipboard group circled, which includes the cut, 
copy, paste, and paintbrush commands (buttons). 
 

 
 
Displaying Additional Options  
Not all commands and tabs are visible when you first open the program. For 
example, the Picture Tools and Format tab appear only after you insert a picture. 
In essence, the Ribbon displays only the commands needed based on the 
current action. 
 
The small arrow (Dialog Box Launcher) in the bottom right corner of a group 
indicates more available options for the group. Click the arrow to display a dialog 
box or task pane with additional commands. 
 
For example, in many programs the Font group contains the most commonly 
used commands for font changes. Clicking the Dialog Box Launcher displays 
the Font dialog box with additional options for you to change. 
 
 
If you are using the previous versions of Office, the old Formatting toolbar that 
contained the most commonly used commands and the Format drop-down 
menu, from which you could choose to display the same Font dialog box. 
 
 
In addition to the interface changes, you should notice that some features have 
been enhanced and work more like they should (namely, the Spell Checker). 
New features have been added, such as SmartArt and Themes. This section 
briefly describes the major application-specific changes to Office 2007. 
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Application-specific Changes - Word 2007 
 
Office Button 
The Word Office Button contains many of the items from the old File menu and 
more. For example, the Save As feature includes new options to save the 
document as a Word Template (previously done in the Save As window), Word 
97-2003 Document (so users with older versions can work with your files), and 
Other Formats (opens the Save As window to save in formats such as .rtf, etc.).  
 
The Find add-ins for other file formats option replaces the Templates and Add-
Ins feature (previously accessible from the Tools menu) and allows you to find an 
ad-in that allows you to save a file as a PDF, for example. 
Remember, if the menu item has a right-facing arrow on the right, additional 
related options are available. 
 
Ribbon 
The Ribbon in Word 2007 contains the same tools and options as before (with a 
few additions), organized in a different way. 
 

 
 
The ribbon is designed to help you quickly find the commands that you need to 
complete a task. The ribbon is divided into eight tabs by default, and each tab is 
a selection of groups that show related items together. Command buttons in each 
group carry out a command or display a menu of commands.   
 
The following describes each tab. 
 

¶ Home - This tab contains the most commonly used tools for writing and 
formatting fonts, styles, lists, etc. Options are grouped by Clipboard, Font, 
Paragraph, Styles, and Editing. 
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¶ Insert - This tab replaces the old Insert menu and includes items from the old 
View menu and a couple new options. Options are grouped by Pages, 
Tables, Illustrations, Links, Header & Footer, Text, and Symbols. 

 

 
 

¶ Page Layout - Many of the items on this tab were accessible from the old 
File menu (File - Page Setup). However, other items (like Columns and 
Breaks) were moved from the old Format and Insert menus. Some features, 
such as Themes, are new. Options are grouped by Themes, Page Setup, 
Page Background, Paragraph, and Arrange. 

 

 
 

¶ References - This tab contains many items that were accessible from the old 
Insert menu (Insert - References). Options are grouped by Table of Contents, 
Footnotes, Citations & Bibliography, Captions, Index, and Table of 
Authorities. 

 

 
 

¶ Mailings - This table includes many new items, as well as items from the old 
Tools menu (Tools - Letters and Mailings). Options are grouped by Create, 
Start Mail Merge, Write & Insert Fields, Preview Results, and Finish. 

 


